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(1) �You don’t have to read  
this book in order.

You can treat this as a “jump-in-any-
where” book, because I didn’t write  
it as a “build-on-what-you-learned-in-
Chapter-1” type of book. For example, 
if you just bought this book, and you 
want to learn how to convert an image 
to black and white, you can just turn 
to Chapter 9, find that technique, and 
you’ll be able to follow along and do it 
immediately, because I walk you through 
each step. So, if you’re a more advanced 
Elements user, don’t let it throw you 
that I say stuff like “Go under the Image 
menu, under Adjust Color, and choose 
Levels,” rather than just saying “Open 
Levels.” I did that so everybody could 
follow along no matter where they are 
in the Elements experience.

(2) �Not everything about Elements  
is in this book.

I tried hard not to make this a giant 
encyclopedia of Elements features. So, 
I didn’t include tutorials on every fea-
ture in Elements. Instead, it’s more like 
a recipe book—you can flip through 
it and pick out the things that you want 
to do to your photos and follow the 
steps to get there. Basically, I just 
focused on the most important, most 
asked-about, and most useful things 
for digital photographers. In short—
it’s the funk and not the junk.

It’s really important to me that you get a lot out of reading this book, and one 
way I can help is to get you to read these 10 quick things about the book that 
you’ll wish later you knew now. For example, it’s here that I tell you about where 
to download something important, and if you skip over this, eventually you’ll send  
me an email asking where it is, but by then you’ll be really aggravated, and well… 
it’s gonna get ugly. We can skip all that (and more), if you take two minutes now  

to read these 10 quick things. I promise to make it worth your while.

Ten Things 
You’ll Wish You  
Had Known Before 
Reading This Book

The Photoshop Elements 14 Book for Digital Photographers

xii Introduction xiiiThe Photoshop Elements 14 Book for Digital Photographersxii
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(3) �Practice along with some of  
the same photos I used here  
in the book.

As you’re going through the book, and 
you come to a technique like “Adding 
Contrast and Drama to Cloudy Skies,” 
you might not have cloudy sky image 
hanging around. I made most of the 
images used in the techniques avail-
able for you to download, so you can 
follow along with them. You can find 
them at http://kelbyone.com/books/
elements14 (see, this is one of those 
things I was talking about that you’d 
miss if you skipped this and went right 
to Chapter 1).

(4) �There’s a bonus chapter  
on portrait retouching.

Every time Adobe adds a bunch of new 
features to Elements, I add those fea-
tures to this book, and what you’re hold-
ing in your hands is the 14th edition of 
the book. If I did nothing but add all the 
new features in each edition, this book 
would probably be over a thousand 
pages by now (and sadly, cost triple the 
price). So, rather than just cutting pages 
to make room for the new stuff (and to 
keep the cost of the book affordable), 
I’ve put the Retouching Portraits chapter 
online for you as a bonus chapter. That 
way, you still get the techniques, but 
without paying more money (and hav-
ing to lug around a 22-lb. book). You can 
find this bonus retouching chapter on 
the book’s companion webpage at the 
web address I just mentioned in #3.

xiv
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(6) �There are things in Elements 14 
and in Camera Raw that do the 
exact same thing.

For example, there’s a way to reduce 
noise in a photo in Camera Raw and 
there’s a way to do it in the Elements 
Editor, as well. And, they look almost 
identical. What this means to you is 
that some things are covered twice in 
the book. As you go through the book, 
and you start to think, “This sounds 
familiar,” now you know why. By the 
way, in my own workflow, if I can do 
the exact same task in Camera Raw or 
the Editor, I always choose to do it in 
Camera Raw, because it’s faster (there 
are no progress bars in Camera Raw) 
and it’s non-destructive (so I can always 
change my mind later).

(5) �The intro pages at the beginning 
of each chapter are not what 
they seem.

The chapter introductions are designed 
to give you a quick mental break be-
tween chapters, and honestly, they have 
little to do with what’s in the chapter. In 
fact, they have little to do with anything, 
but writing these quirky chapter intros 
has become kind of a tradition in all my 
books, so if you’re one of those really 

“serious” types, I’m begging you, skip 
them and just go right into the chapter 
because they’ll just get on your nerves. 
However, the short intros at the begin-
ning of each individual project, up at 
the top of the page, are usually pretty 
important. If you skip over them, you 
might wind up missing stuff that isn’t 
mentioned in the technique itself. So, 
if you find yourself working on a tech-
nique, and you’re thinking to yourself, 

“Why are we doing this?” it’s probably 
because you skipped over that intro. So, 
just make sure you read it first, and then 
go to Step One. It’ll make a difference—
I promise.

xv
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(8) What new stuff is in this book?
Elements 14 is a significant upgrade for 
photographers, and thankfully Adobe 
continued with their tradition of taking 
some of the coolest features from the 
full-blown version of Photoshop CC and 
bringing them over to Elements (but 
usually in a much more refined or easier-
to-use way, so it feels right at home here 
in Elements). Some of the big features 
they brought over in this update include 
Photoshop’s Shake Reduction filter (it 
helps sharpen photos that are blurry due 
to camera movement when you took the 
shot), and the amazing Haze Removal 
filter, which cuts through hazy or foggy 
images with just a simple slider (this has 
been a huge hit with users in Photoshop 
CC and Lightroom CC), along with im-
proved panoramas, a simple-to-use 
Straighten tool, auto Smart Looks in 
Quick mode, some new Guided mode 
effects, like Speed Effect that gives the 
effect of slow shutter-speed motion,  
plus a lot more. And, of course, all  
the cool new stuff is covered here  
in the book. 

(7) �I included my Elements 14 work-
flow, but don’t read it yet.

At the end of Chapter 11, I included 
a special tutorial detailing my own 
Elements 14 workflow. But, please don’t 
read it until you’ve read the rest of the 
book, because it assumes that you’ve 
read everything else in the book already, 
and understand the basic concepts, 
so it doesn’t spell everything out (or it 
would be one really, really long drawn-
out tutorial).

xvi
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(10) �This book is for Windows  
and Mac users.

Elements 14 is available for both  
Windows and Macintosh platforms, 
and the two versions are nearly identi-
cal. However, there are three keys on 
the Mac keyboard that have different 
names from the same keys on a PC key-
board, but don’t worry, I give you both 
the Windows and Mac shortcuts every 
time I mention a shortcut (which I do a 
lot). Also, the Editor in Elements 14 is 
the same on both platforms, but the 
Organizer (where we sort and organize 
our images) was only made available on 
the Mac starting with Elements 9. As a 
result, there are some Organizer func-
tions that still aren’t available on the Mac 
yet, and I’ve noted it in the book wher-
ever this is the case.

Okay, that’s the scoop. Thanks for taking 
a few minutes to read this, and now it’s 
time to turn the page and get to work.

(9) �Photography is evolving, 
Elements is evolving, and  
this book has to, too.

If it looks like a lot of the book is dedi-
cated to covering Camera Raw, it’s be-
cause it has become the “go-to” tool 
for today’s photographers. It offers so 
many advantages, and it’s not just its 
non-destructive nature (it doesn’t ever 
harm your RAW original—it kind of 
treats it like we treated negatives back 
in the day). Beyond that, it’s so much 
faster, more flexible, and just easier to 
understand and learn, so it makes sense 
to do as much as we can in Camera 
Raw first before we take the image fully 
into Elements (not to mention the fact 
that Camera Raw is not just for RAW im-
ages—it works with JPEGs and TIFFs, 
too). Camera Raw is where photogra-
phers today are focusing their time and 
efforts, so I dedicate quite a bit to mak-
ing sure you’re making the most of it in 
your Elements workflow.
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If you’re w this chapter opener (and you are, by the way), 

it’s safe to assume that you already read the warning about 

these openers in the introduction to the book (by the way, 

nobody reads that, so if you did, you get 500 bonus 

points, and a chance to play later in our lightning round). 

Anyway, if you read that and you’re here now, you must be 

okay with reading these, knowing full well in advance that 

these have little instructional (or literary) value of any kind.  

Now, once you turn the page, I turn all serious on you, and 

the fun and games are over, and it’s just you and me, and 

most of the time I’ll be screaming at you (stuff like, “No, 

no—that’s too much sharpening you goober!” and “Are 

you kidding me? You call that a Levels adjustment?” and 

“Who spilled my mocha Frappuccino?”), so although we’re 

all friendly now, that all ends when you turn the page, 

because then we’re down to business. That’s why, if you’re 

a meany Mr. Frumpypants type who feels that joking has 

no place in a serious book of learning like this, then you 

can: (a) turn the page and get to the discipline and order 

you crave, or (b) if you’re not sure, you can take this quick 

quiz that will help you determine the early warning signs of 

someone who should skip all the rest of the chapter open-

ers and focus on the “real” learning (and yelling). Question 

#1: When was the last time you used the word “poopy” 

in a sentence when not directly addressing or referring 

to a toddler? Was it: (a) During a morning HR meeting? 

(b) During a legal deposition? (c) During your wedding 

vows? Or, (d) you haven’t said that word in a meaningful  

way since you were three. If you even attempted to 

answer this question, you’re clear to read the rest of  

the chapter openers. Oh, by the way: pee pee.  

(Hee hee!)

ORGANIZED CHAOS
managing photos using the organizer

Chapter 1  Managing Photos Using the Organizer
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Importing 
Your Photos

Step One:
When you attach a memory card reader 
to your computer (or attach your camera 
directly using a USB cable), the Elements 
Organizer – Photo Downloader standard  
dialog appears onscreen (if you have 
it set that way; by the way, it will also 
download photos from your mobile 
phone). The first thing it does is it 
searches the card for photos, and then  
it tells you how many photos it has 
found, and how much memory (hard 
disk space) those photos represent.

TIP: Import in Bulk
If you have a lot of images on your 
computer that you’d like to import 
into the Organizer, a new feature was 
added in Elements 14 that lets you 
easily import a large number of im-
ages at once. Just go under the File 
menu, under Get Photos and Videos, 
and choose In Bulk.

Step Two:
The Import Settings section is where you 
decide how the photos are imported. 
You get to choose where (on your hard 
disk) they’ll be saved to, and you can 
choose to create subfolders with photos 
sorted by a custom name, today’s date, 
when they were shot, and a host of  
attributes you can choose from the 
Create Subfolder(s) pop-up menu (as 
shown here).

One of the major goals of Adobe Photoshop Elements is simply to make your  
life easier and the Photo Downloader is there to help do just that. Adobe has 
not only made the process of getting your photos from your digital camera 
into the Elements Organizer much easier, they also included some automation  
to make the task faster. Why? So you can get back to shooting faster. Here’s 
how to import your photos and take advantage of this automation:
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Step Three:
If you want to rename files as they’re 
imported, you can do that in the next 
field down. You can use the built-in 
naming conventions, but I recommend  
choosing Custom Name from the  
Rename Files pop-up menu, so you  
can enter a name that makes sense to 
you. You can also choose to have the 
date the photo was shot appear before 
your custom name. Choosing Custom 
Name reveals a text field under the 
Rename Files pop-up menu where you 
can type your new name (you get a 
preview of how it will look). By the way,  
it automatically appends a four-digit 
number starting with 0001 at the end  
of your filename to keep each photo 
from having the same name.

TIP: Storing the Original Name
If you’re fanatical (or required by your 
job) and want to store the original file
name, turn on the Preserve Current 
Filename in XMP checkbox and your 
original filename will be stored in the 
photo’s metadata.

Step Four:
The last setting here is Delete Options. 
Basically, it’s this: do you want the pho-
tos deleted off your memory card after 
import, or do you want to leave the 
originals on the card? What’s the right 
choice? There is no right choice—it’s 
up to you. If you have only one memory 
card, and it’s full, and you want to keep 
shooting, well…the decision is pretty 
much made for you. You’ll need to  
delete the photos to keep shooting.  
If you’ve got other cards, you might  
want to leave the originals on the card 
until you can make a secure backup of 
your photos, then erase the card later.
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Step Five:
Beneath the Delete Options pop-up 
menu is the Automatic Download check
box (this feature is currently only avail-
able in the PC version of Elements 14) 
and this feature is designed to let you 
skip the Photo Downloader. When you 
plug in a memory card reader, or cam-
era, it just downloads your photos using 
your default preferences, with no input 
from you (well, except it asks whether 
you want to erase the original photos on 
the card or not). Now, where are these 
default preferences set? They’re set in  
the Organizer’s Preferences. Just go 
under the Organizer’s Edit menu, under 
Preferences, and choose Camera or  
Card Reader. This brings up the Pref
erences dialog you see here.

Step Six:
Here is where you decide what happens 
when you turn on the Automatic Down
load checkbox in the Photo Downloader. 
You get to choose a default location 
to save your photos (like your Pictures 
folder), and whether you want it to auto
matically fix any photos that it detects 
have red eye. You can also choose to 
have it automatically suggest photo 
stacks (it groups photos it thinks belong 
together), or make a keyword tag. You 
can have settings for specific cameras 
or card readers (if you want separate 
settings for your mobile phone, or a par-
ticular camera). At the bottom, you’ve 
got some other options (when to begin 
the downloading, if you’re going to have 
subfolders, and your delete options). 
Click OK when the preferences are set 
the way you want them.
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Step Seven:
Okay, back to the Photo Downloader. 
Now, at this point, all the photos on the 
card will be imported, but if you want to 
import just a few selected photos, then 
you’ll need to click on the Advanced 
Dialog button at the bottom-left corner  
of the dialog (shown at the top). That 
expands the dialog and displays thumb-
nails of all the photos on the card. By 
default, every photo has a checkbox 
turned on below it, indicating that every 
photo will be imported. If you just want 
some of these photos imported, then 
you’ll need to click the UnCheck All but-
ton at the bottom left of your thumbnails. 
This turns off all the photos’ checkboxes, 
which enables you to then go and turn 
on the checkboxes below only the pho-
tos you actually want imported.

Step Eight:
When you look at the right side of the 
dialog, you’ll see some familiar Save 
Options (the subfolder choice, renaming 
files), and in the Advanced Options sec-
tion, you’ll see choices to automatically 
fix red eyes, suggest photo stacks, make 
a tag, import into an album, and delete 
options. Another nice feature is the abil-
ity to embed metadata (like your name 
and your copyright info) directly into the 
digital file, just like your camera embeds 
information into your digital camera im-
ages. So, just type in your name and 
your copyright info, and these are em-
bedded into each photo automatically 
as they’re imported. This is a good thing. 
When you click Get Media, your photos 
are imported (well, at least the photos 
with a checkmark under them). If you 
want to ignore these advanced features 
and just use the standard dialog, click  
on the Standard Dialog button.
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Step One:
To back up your catalog to a hard drive  
or disc, you simply go under the Organ
izer’s File menu and choose Backup 
Catalog (as shown here; currently in  
the Mac version of Elements 14, you  
can only back up to a hard drive).

TIP: �Back Up to an External  
Hard Drive

We recommend backing up to an  
external hard drive. They’re much larger 
than a CD, or even a DVD, and easier 
to manage. Plus, you can always take 
them with you or to a nice off-site loca-
tion to really keep your backups safe. 
You can get a 1-TB external hard drive 
for around $50, and a 3-TB drive for 
around $90.

When you think about backing up, I’d like you to consider this: it’s not a matter  
of if your hard drive will crash, it’s a matter of when. I’ve personally had new and  
old computers crash. So many times that now I’m totally paranoid about it. Sorry,  
but it’s a harsh fact of computer life. You can protect yourself, though, by backing  
up your entire catalog to a disc or hard drive, and/or using an online backup, so  
your photos are protected in an off-site location. So even if your hard drive dies  
or your computer is lost, stolen, damaged in a fire, flood, or hurricane, you can  
retrieve your images.

Backing Up Your 
Photos to a Disc  

or Hard Drive
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Step Two:
This brings up a dialog where you  
decide whether to do a Full Backup  
(you choose this the first time you back 
up your catalog), or an Incremental Back
up (which is what you’ll choose after your  
first backup, as it only backs up the files  
that have changed since your last back
up, which is a big time saver). In this 
case, since this is your first time, choose 
Full Backup (as shown here), then click 
the Next button.

Step Three:
When you click Next, the Destination 
Settings screen appears, which is basi-
cally where you tell Elements to back 
up your stuff to. If it’s a DVD or CD, just 
insert a blank DVD or CD into your DVD/
CD drive and choose that drive from 
the list. Give your disc a name, click 
the Save Backup button, and it does 
its thing. Same thing for a hard drive—
just choose it from the list and click 
the Save Backup button.
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Step One:
In the Elements Organizer, go under  
the File menu, under Get Photos and 
Videos, and choose From Scanner. By 
the way, in the Organizer, you can also 
use the shortcut Ctrl-U to import pho-
tos from your scanner or click on Import 
just below the menu bar and choose 
From Scanner. (Note: This feature is  
currently only available in the PC  
version of Elements 14.)

Step Two:
Once the Get Photos from Scanner  
dialog is open, choose your scanner  
from the Scanner pop-up menu. Choose 
a high Quality setting (I generally choose 
the highest quality, unless the photo is 
for an email to my insurance company 
for a claim—then I’m not as concerned), 
then click OK to bring in the scanned 
photo. See? Pretty straightforward stuff.

If you’re reading this and thinking: “But this is supposed to be a book for  
digital photographers. Why is he talking about scanning?” Then ask yourself  
this: “Do I have any older photos lying around that I wish were on my  
computer?” If the answer is “Yes,” then this tutorial is for you. We’ll take  
a quick look at importing scanned images into the Organizer.

Importing Photos  
from Your Scanner
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Step One:
The size of your thumbnails is con-
trolled by a slider below the right side 
of the Media Browser. Click-and-drag 
the Zoom slider to the right to make 
them bigger and to the left to make 
them smaller.

TIP: Jumping Up a Size
To jump up one size at a time, click on 
a thumbnail, then press-and-hold the 
Ctrl (Mac: Command) key and press 
the + (plus sign) key. To go down in 
size, press Ctrl-– (minus sign; Mac: 
Command-–).

Step Two:
To jump to the largest possible view,  
just double-click on your thumbnail. At 
this large view, you can enter a caption 
directly below the photo by clicking 
on the placeholder text (which reads 

“Click here to add caption”) and typing 
in your caption. (Note: If you don’t see 
this text, go under the View menu and 
choose Details.) Press Esc to return to 
the grid view, or click on the Grid button  
in the top left of the Media Browser.

We all have our personal preferences. Some people like to cram as  
many photos onscreen at once as they can, while others like to see the  

photos in the Organizer’s Media Browser at the largest view possible.  
Luckily, you have total control over the size they’re displayed at.

Changing the  
Size of Your  
Photo Thumbnails



Managing Photos Using the Organizer10 Chapter 1

The Photoshop Elements 14 Book for Digital Photographers

Step One: 
To see a full-screen preview of your  
currently selected photo(s), go under 
the View menu, and choose Full Screen 
(or press F11 [Mac: Command-F11]).

Step Two:
This brings you into Full Screen view, 
and your photo should appear large on-
screen with everything else black around 
it. This is really a way to launch into a 
slide show, but if you don’t do anything 
here, you’re simply just viewing your 
photos in a larger view. If you want to 
return to the Media Browser, press the 
Esc key on your keyboard. But wait, 
there’s more.

If you like seeing a super-big view of your photos, then use Elements’ Full Screen 
view. It shows you a huge preview of a selected thumbnail without having to  
leave the Organizer. Here’s how:

Seeing  
Full-Screen  

Previews
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Step Three:
Once your photo(s) appears full screen, 
there’s a control palette at the bottom 
of the screen where you can control 
your viewing options—click the Play 
button to start moving through your 
photos and click the Pause button to 
stop. You can also click the Right Arrow 
and Left Arrow buttons to view the next 
or previous photo.

Step Four:
One more thing: Try clicking the Toggle 
Film Strip button on the control palette 
(or just press Ctrl-F [Mac: Command-F]). 
This opens a filmstrip view of your pho-
tos on the bottom of the screen. So you 
don’t necessarily have to click the Right 
Arrow button or press the Right Arrow 
key a bunch of times to get to a photo 
that’s 25 photos into your list. You can 
just scroll the filmstrip until you see it 
and click on it. Nifty, huh?
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Sorting Photos  
by Date and  

Viewing Filenames

When photos are imported into the Organizer, the Organizer automatically sorts  
them by date. How does it know on which dates the photos were taken? The time  
and date are embedded into the photo by your digital camera at the moment the  
photo is taken (this info is called EXIF data). The Organizer reads this info and then  
sorts your photos automatically by date, putting the newest ones on top. You can 
change that, though, and you can choose whether or not to view your filenames.

Step One:
By default, the newest photos are  
displayed first, so basically, your last 
photo shoot will be the first photos in  
the Organizer. You can see the exact  
date and time each photograph was 
taken by going under the View menu,  
and choosing Details. If you want to  
see the filenames, then under the View 
menu, choose File Names, as well.

Step Two:
If you’d prefer to see your photos in  
reverse order (the oldest photos up top),  
then choose Oldest from the Sort By 
pop-up menu above the top left of the 
Media Browser. There you have it!




